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Help

Use this list of frequently asked questions to get help on how to do things in your community. For a step-
by-step tour, be sure to see the Quick Tour.

Getting Started

What can I do in Jive SBS?
Jive SBS is a collaboration application that you use through a web browser. In Jive SBS you can:

• Create and find content. From documents to blogs to discussions, pick the best vehicle for your
thoughts. For more information, see:

• What kinds of content can I create? (page 15)
• How can I find content? (page 36)

• Ask questions. Discussions and polls provide ways to take the pulse of your community. Also see:
• What can I do with discussions? (page 25)
• How do I create a poll? (page 35)

• Share ideas and ask for feedback.
• What can I do with blogs? (page 24)
• What can I do with discussions? (page 25)

• Collaborate with other people. 
• What is a project? (page 39)

• Stay on top of what's happening.
• How can I find content? (page 36)
• How do I keep track of content I like? (page 37)

How do I edit my profile?
Your profile is a quick way for other members of your team to find out more about you. It can be bare
bones or more thorough. If you fill in the optional fields, you can give others a sense of who you are
and what you know. It can be very useful in a team to know who to go to when you've got a question or
suggestion in mind.

1. Click Your Stuff > Profile to view your profile.
2. On your profile page, notice that the Actions list lists a few things you can do. On the preferences

page you can adjust your notification settings, as well as your locale and how discussion threads are
displayed.

3. Click Edit Profile.
4. Fill in as much profile information as makes sense. Keep in mind that your profile will be found when

people search, so if you have professional roles or interests that would be useful for others to know,
be sure to include them.

How do I change my password?
If your community is set up for it, you can change your password. There are two ways to change it: ask
to have it reset to something else or simply change it to something else in your profile.

If you can, it's a good idea to change your password every now and then -- say, every six months or so.
Be sure to take a look at How can I make a password that's hard to guess? (page 4)

• If you forget your password, you can have it reset. On the login page, click Forgot my password,
then follow the instructions in the email you receive.

• If you just want to change the password, go to your profile by clicking Your Stuff, then clicking
Profile. Under Actions, click Change password.
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How can I make a password that's hard to guess?
By making a password that's strong enough to stump the guessers, you're not only protecting your
own content (including any private content you have), but also the content and activity of others in the
community. Here are a few guidelines for making a password that only you know.

Note:  If your community allows you to create your own password, be sure to keep an eye on the
password strength meter on the page where you change it. As you type your new password, the meter
will show how strong you've got it so far, and what you can do to make it stronger. See How do I change
my password? (page 3)  for more.
Any strong password has:

• At least six characters (although you're better off with eight or more).
• At least three characters that are upper-case, lower-case, numerals, or punctuation.

Here are a few tips for getting that strong password:
• Try using words instead of numbers -- "six" instead of "6", for example.
• Use numerals instead of letters here and there -- "0" instead of "o" would work.
• Mix uppercase and lowercase letters -- as in "feLiX".
• Add punctuation or other special characters. You could throw in a "&" or "$" or "@" -- pretty much

anything you like, really.

Where can I find and put content?
When you create new piece of content, including a discussion or document or video, you're prompted
to choose a place for it. And when you browse or search for content, you can look specifically in certain
places. Each of the places you'll see in the community -- including spaces, projects, and groups -- has a
different purpose.

Shortcuts

Social groups. Discussions. Projects. Documents. Spaces. Blog posts.

You can make quite a few things and you can put them in quite a few places. Fortunately, you'll find
a few ways to make getting to what you want -- and what you want to create -- a little easier. When
you customize your home page, for example, you can pick widgets specifically for the ways you like to
browse, and the kinds of things you tend to look for.

• Places widget. Use the Places widget to give you a list of places in the community. This includes
spaces, projects, and groups. You can even use the widget to search for a place. It doesn't show
you what's in the place, but gives you a handy way to browse the list.

• Place-specific widgets. The Spaces, Your Groups and Your Projects widgets don't just list the places
-- they also give information about what's going on inside them.

• Content-specific widgets. There's a separate widget for most kinds of content in the community. Use
them to get snapshots of what's most recent or popular.

• Search results filtering. When you search, you can filter the results according to the kind of content
it is, by the place it might be in, or the person who authored it.

Keep in mind that while you put most things in a place when you create them, you don't have to go
to that place to view them later. Most of the things you can create are also visible (at least, in lists)
in widgets you put on your personalized home page. When you personalize your home page, look for
widgets that list the content you're more interested in keep track of. See How can I personalize my view
of content? (page 5)  for more information.

Where to put that

Here's a list of the places you might find in your community (not every community has all of them). Each
space, project, or group might allow only certain kinds of content -- it all depends on how the place is set
up.
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• Space -- You'll probably find that spaces are arranged hierarchically, with some spaces containing
other spaces. Spaces usually represent some ongoing or organizational concern -- a department
in a company, for example, or a product. As a result, spaces are often created with some planned
structure in mind and tend to stick around for quite a long time.

• Project -- Projects usually represent something that's time-based -- something with a deadline.
They have tasks and milestones, for example. In a project, you can put the kinds of content allowed
by the place that contains the project. For example, if the space that contains a project doesn't
allow discussions, then you can't put discussions in the project either. A project can also have its
own blog.

• Social group -- Social groups usually spring up and evolve around people's shared interests. They
grow and diminish with that interest. You might need to be a member of a social group in order to
put stuff there (it depends on the group).

• Your Place -- Okay, so there isn't really a "your place." Rather, it's a way to refer to where things
go when you create something that's just for you and isn't in another place. So when you create a
discussion or a document, for example, you can say that you want it to go in "your documents" or
that you want to create a "private discussion." When you do, you'll be able to get to it later on your
profile.

The following table lists kinds of content and describes where you might be able to put them when you
create them. When you're creating (or looking for) new content, remember that a place defines its own
rules for what can go in it. So you might be able to create a document in one place, but not in another.

Kind of Content Places

Blog post You can post to any existing blog that, well, you're allowed to post to. Blog posts
are a little different from other kinds of content. A blog post is always associated
with a particular blog, and a blog is usually in a particular place already. That place
could be a space or a social group, for example. Or a blog could be your personal
blog (which is an exception in that it doesn't really live anywhere in a particular
place). In other words, when you create a new blog post and choose a place to put
it in, you're actually choosing the blog that's in that place. (Actually, this is one of
those cases where doing it is much easier than understanding it. You'll see.)

Bookmark When you create a bookmark, it doesn't really go anywhere in particular.

Discussion You can post discussions in spaces, projects, and social groups. You can also make
private discussions.

Document You can create a document in spaces, projects, and social groups. You can also
create a document that lives in "your place."

Task Tasks typically go in projects, but you can also create personal tasks that don't.

Video Videos you create can go in spaces, projects, and social groups. You can also put a
new video in "your place."

How can I personalize my view of content?
You can personalize the home page so that it shows the things you care about most. As you and others
use the community, the amount of content there will grow. You'll develop a preference for certain people's
blogs, for discussions in certain areas. And you'll learn that some areas just rarely have something you
need. When personalizing your view, you use widgets, which are windows on content inside and outside
the community, even into other communities you're a member of.

You'll probably spend a lot of time in your personalized page, but if you ever want to see the full view of
content again, click the All Content tab.

To start personalizing your home page, click the Your View tab, then click the personalize link. Jive SBS
will display a layout screen with a set of widgets listed at the top and a default layout beneath it. Here are
a few simple steps for customizing:
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Quick Steps

Here's the quick-and-easy look at designing a page with widgets.

1. To start customizing a page, go to the tab that will display your layout.
• If you're personalizing the home page, this will be the Your View tab.
• If you're customizing an overview page, this will be the Overview tab.

You'll get a layout screen with a set of widgets listed at the top and a default layout beneath it.
2. In the layout area beneath, find widgets you don't want displayed on the page and click their

Remove this widget link (it's under the arrow in the widget's upper right corner).
3. In the widgets list above, find widgets you want and drag them onto the layout area.

If you're connected to another community you're a member of, click the tab with that community's
name to get a list of the widgets related to that community.

4. Tailor a widget to your needs by clicking its Edit this widget link (it's under the little arrow in the
widget's upper right corner).
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5. Click a layout to arrange your layout's columns.

6. Repeat steps 2 through 5 until you have what you want, then click Publish Layout.

You'll probably spend a lot of time in your personalized page, but if you ever want to see the full view of
content again, click the All Content tab.

Widgets Available

The following lists the widgets and the categories they belong to.

Your View

These widgets are available for people personalizing their home page.

Content

Featured Content Popular Blog Posts Popular Bookmarks

Popular Discussions Popular Documents Popular Tags

Popular Videos Recent Activity Recent Blog Posts

Recent Content Recent Discussions Recent Documents

Recent Videos Unanswered Questions View Document

Watch A Tag Watch A User Your Content

Your Tasks Your Videos  '

Places

Places Spaces Your Groups
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Places

Your Projects  '  '

People

Connection Activity Newest Members Recent Activity

Status Updates Top Participants Watch A User

Other

Formatted Text HTML Latest Poll

Private Messages Quick Tips Recent Bookmarks

RSS Subscription Your Bookmarks  '

How can I get a summary of activity in the community?
You can set your preferences so that you'll receive an email that collects news about things about you and
the community that have happened lately. The links in the summary are a convenient way to go right to
the content listed. If you're already getting a summary, you can cancel it or change its frequency.

Here's a list of what the summary includes:
• Your status. If you've entered a status message, it'll be here.
• A list of activity around your content. If you've created or commented on content, for example, it'll

be listed here. This list will also include notes about content of yours that was viewed or commented
on by others.

• A list of activity by people connected to you.
• A list of popular content in the community.

To start getting a summary or to edit your summary preference:
1. Go to Your Stuff > Preferences.
2. Click the General Preferences tab.
3. Under Email Notifications Preferences, next to Send me an email summary, click the

frequency you want. (Summaries are sent at 10 in the morning.)

How can I set default preferences for things like notifications, time
zone, and locale?

Go to Your Stuff > Preferences. On the Your Preferences page, you'll be able to set your locale and
time zone. You can also set whether a discussion thread and its replies should be displayed all on one
level (flat) or indented hierarchically (threaded).

You might want to ensure you have the right locale chosen here if you intend to use Jive SBS from
web browsers set to another locale -- such as in an Internet cafe in another country, for example. Your
preference here takes precedence. By the same token, if you want to make sure you use the locale set by
an administrator for the entire community, make sure that your web browser doesn't have a locale set (or
else the browser locale will override the community setting).

In the email notifications preferences you can set whether you should automatically get an email when
you create or comment on content.

You can choose to regularly receive a summary that briefly lists community activity you might care about.
This includes activity related to your content, your connections, and popular items in the community. You
can set when the summary is sent to you -- daily, semi-weekly (Tuesday and Friday), weekly (Thursday),
or never. By default, the summary is sent at 9 a.m. on the days you specify here.

How can I use the keyboard to control menus?
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You have access to menus through the keyboard. The exact keyboard combination will vary depending on
which browser you're using, as show in the table below. Note that once the menu is open you can use the
up and down arrow keys to navigate; press ENTER to select an item.

New ALT+SHIFT+N ALT+N CTRL+N

Your Stuff ALT+SHIFT+Y ALT+Y CTRL+Y

History ALT+SHIFT+H ALT+H CTRL+H

Browse ALT+SHIFT+B ALT+B CTRL+B

Search ALT+SHIFT+S ALT+S CTRL+S

Login ALT+SHIFT+L ALT+L CTRL+L

Register ALT+SHIFT+R ALT+R CTRL+R

Print ALT+SHIFT+P ALT+P CTRL+P

Connecting With People

How can I find people?
You can search for people based on the content in their profiles, very much as you would search for
content. This works even better when you and other people add to your profiles information that the rest
of the community might be interested in. For example, you could add a list of the things you're skilled at,
a list of your interests, and so on.

To find people, click Browse > People. On the People page, enter the terms you want to search for,
then click Search People. If you get a lot of results from your search, you can narrow the list further by
using the filter options to the right of the list.

When you click the name of someone in the search results list, you can get their profile and a lot more.
You also get lists of the person's content, tags they commonly use, and more.

How do I invite people to join the community?
If it's enabled for your community, you can invite people from outside the community to join. When you
invite them, they'll receive an email with instructions on how they can join.

Go to your profile (at Your Stuff > Profile) or to a space home page. In the Actions list click Invite
friends to join. Fill out the short form to build the email that they'll receive, then click Invite Friends.

Note:  Here's a shortcut. Click New > Invitation. You won't get as many tips on who to invite, but you
know what you're doing already, right?

How do I send private messages to other people?
If the private messaging feature is available for your community, you can send messages to other people
in the community. Click Your Stuff > Private Messages, then click Compose Message.

Notice that you can manage private messages in the way some applications let you manage email.
In addition to receiving and replying, you can create new folders for storing messages, save drafts of
messages in progress, and so on.

What are friends and connections?
You can add people as friends or connections when you want to keep up with what they're working on.
When you create friends or connections (either by following them or adding them as friends), Jive SBS
will show you the things they've been doing — posting to discussions or their blog, creating documents,
and so on. You can also send messages to your friends.
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Your list of friends or connections appears on the Friends or Connections tab of your profile. You can
also add a widget for a view of your friends or connections when you personalize your home page.

To get started, go to someone's profile and click the link to friend or follow them. For more information,
see How can I add someone to my list of friends or connections? (page 10)

How can I add someone to my list of friends or connections?
Depending on how your community it set up, you can either "follow" someone or add them as a friend
("friend" them). When you choose to friend or follow someone, they're added to your list of connections
(although they might need to approve it first).

Friending someone creates a two-way relationship with them -- they become your friend, too.

Following someone is a one-way relationship. They show up in the list of people you're following, but you
don't necessarily show up in theirs (unless they choose to follow you).

You can remove someone on your friends or connections page. Go to Your Stuff > Connections or
Your Stuff > Friends, then find the person you want to remove from the list. To remove them, click the
Remove link on their listing.

How can I see what my connections are up to?
The easiest way to keep up with friends is on your home page. When you personalize your home page,
you can add the Friend Activity or Connection Activity widget. This one is like the Recent Activity
widget except that it lists activity by your friends or connections only. As your friends or connections
create new documents, make discussion or blog posts, and so on, what they do will show up in the
widget.

How can I group people to make them easier to keep track of?
You can create labels to group your friends or connections. When you apply a label to multiple friends or
connections, the label becomes a way to group those people and the list to include only those with certain
labels.

To create a label, first view your friends or connections by going to Your Stuff > Connections or Your
Stuff > Friends. Under Filter by label, click Add/edit labels, click Create new label, enter the label
text, then click Save.

To apply a label you've created to a friend, start by going to Your Stuff > Connections or Your Stuff >
Friends. Locate the friend in the list of people you're following, then click the Labels link on their listing.
In the box that appears, under Apply label, click the label you want to apply. To remove a label, click the
Labels link, then click the label under Remove label.

Connecting Through Social Groups

What are groups?
A group is a place for you to connect with people who share an interest. A group can be about anything
you like, such as a work-related interest or a favorite sport. People join a group to connect with
discussions, keep track of things with documents, and have their say with posts to the group's blog.

When someone creates a group, they say what kinds of content the group can contain and who can join.
Here are a few things to know about groups:

• A group can be about anything. No, really: a company soccer team, Linux hacks, or the latest uber-
techno-house-hop releases.

• A group can contain documents, discussions, and blog posts, just as a space can. The group's owner
decides what's allowed.
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• A group can be open to all, hidden, and "by invitation only." It can be set up so that no one but its
members can see it. It can also be visible, but set up so that its owner must give permission for
people to join.

How do I find a group?
You can view a directory of groups by clicking Browse > Groups to get to the main groups page. On that
page, you can also search for groups. Of course, you can also search from anywhere by using the seach
box at the top of each page.

A group can be easier to find when the group's owner has added tags that help describe what the group's
about.

How do I create a group?
Here are the steps to create a group:

1. Click New > Group.
2. On the Create a new group page, enter details for the group you're creating:

Setting What It Means

Group Name The name you want to show up at the top of the group page. This
will be used at the end of a URL that links to the group (though you
can change the URL by clicking the Edit link).

Group Description This will show up on the group's main page. Capture what the
group's about in a way that will attract other people who might be
interested.

Tags Enter words or short phrases that will help other people find your
group. Enter words that describe your group's focus. To separate
the words, put a space between them (you don't need commas). To
separate the words of a single phrase, use underscores.

Group Image A picture to display on the group's main page.

Group Type Choose a type that will determine whether your group can be seen
by others and whether they can participate.

With an open group, anyone can view content or participate at any
time.

In a members only group, anyone see content, but only those
who've joined can participate.

A private group is known to non-members, but only members can
see content or participate. People can only become members after
being invited or approved by the group's owner.

A secret group is invisible to all but its members. People can
become members only by being invited.

Group Features What kinds of content should the group contain?

3. Select which features you want your group to have. People will be able to create the kinds of things
you select.

4. Click Create group.

How do I change a group's details?
If you're a group owner, you can edit details such as the group's name, description, and so on — pretty
much the same things you entered when you created the group. To edit this information, go to the
group's main page, then click Edit group details in the Actions list.
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How do I customize my group's overview page?
If you're a group owner or administrator, you can customize the group's Overview page with widgets. Go
to the page, then click the customize link on the Overview tab. You can drag widgets from the list at
the top of the page, then arrange them on the page as you want them.

Quick Steps

Here's the quick-and-easy look at designing a page with widgets.

1. To start customizing a page, go to the tab that will display your layout.
• If you're personalizing the home page, this will be the Your View tab.
• If you're customizing an overview page, this will be the Overview tab.

You'll get a layout screen with a set of widgets listed at the top and a default layout beneath it.
2. In the layout area beneath, find widgets you don't want displayed on the page and click their

Remove this widget link (it's under the arrow in the widget's upper right corner).
3. In the widgets list above, find widgets you want and drag them onto the layout area.

If you're connected to another community you're a member of, click the tab with that community's
name to get a list of the widgets related to that community.

4. Tailor a widget to your needs by clicking its Edit this widget link (it's under the little arrow in the
widget's upper right corner).
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5. Click a layout to arrange your layout's columns.

6. Repeat steps 2 through 5 until you have what you want, then click Publish Layout.

You'll probably spend a lot of time in your personalized page, but if you ever want to see the full view of
content again, click the All Content tab.

Widgets Available

The following lists the widgets and the categories they belong to.

Group Overview

These widgets are available for a group owner customizing their group's overview page.



Help - 14

Content

Featured Content Featured Video Popular Blog Posts

Popular Bookmarks Popular Discussions Popular Documents

Popular Tags Popular Videos Recent Activity

Recent Blog Posts Recent Content Recent Discussions

Recent Documents Recent Videos Unanswered Questions

View Document  '  '

Places

Projects Related Groups  '

People

Recent Activity Recently Joined Top Participants

Other

Actions Categories Formatted Text

Group Overview HTML Latest Poll

Recent Bookmarks RSS Subscription  '

How do I invite people to join a group?
A group's owner can invite other people by using Jive SBS to send them an email. Go to the group's main
page. In the Actions list, click Invite people to join this group. In the form you get, enter the email
addresses of people you want to invite and feel free to edit the message however you like. Keep in mind
that if you're using a private version of Jive SBS, people who aren't already using it might not be able to
join your group.

If people you want to invite are in your email address book, you can import their contact information.
First, export contact information from the email application as a CSV file. After you've exported, on the
Invite People... page, click the Import Contacts link to import the information into Jive SBS.

Depending on how the group's set up, the group's owner might need to approve new members.

How do I invite people from my contact list to join a group?
You can import contacts from your email program or other contact tracker. You'll need to first export the
contact list as a comma-separated values (CSV) file from your email program. Most email programs give
you the ability to do this.

Once you have the contact list as a CSV file, go to your group's main page and click Invite people to join
this group. There, click the Import contacts link and browse for the CSV file.

If you want to delete or resend invitations, you do so while managing group membership. This can be
handy if you've got a lot of outstanding unanswered invitations. Go to your group's main page, then click
Manage group members. On the Manage group members page, click the Open Invitations link and
select the names of people whose invitations you want to delete or resend. Use the dropdown above the
list to select the action you want to take.

How do I add, delete, or ban group members?
Go to your group's main page, then click Manage group members. On the Manage group members
page, select check boxes for the members you want to manage.
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For the members you've selected, you can ban them from participating, delete their membership, send
them messages, and more. You can also export their member information as a contact list you can then
import into another application, such as an email address book.

You can change a selected member's role from administrator to member, or back the other way. An
administrator role lets the member make the same kinds of changes you can make as the group's owner
(except delete the group).

How do I change, add, or remove group administrators?
A group's administrator has almost all the same abilities to management a group as the group's owner
does. (Although they can't delete the group.)

Go to your group's main page, then click Manage group members. On the Manage group members
page, select check boxes for the members you want to manage.

For the members you've selected, choose an option from the dropdown, such as Change Role to
Administrator or Change Role to Member.

Creating Content

What kinds of content can I create?
Content you create includes documents, uploaded files, blog posts, discussion posts, and tasks.
Depending on your community, you might also be able to create and upload videos. You'll probably
find that each of these types of content is best for particular uses. Be sure to see recommendations for
documents (page 23) , blogs (page 24) , and discussions (page 25) . You can also read more
about the differences (page 23)  between them.

To create new content, click the New menu, then click the type of content you want to create. 

How can I make the most of the content editor?
When you create or edit discussion posts, blog posts, documents, and the like, you use the content
editor built into Jive SBS. The editor includes many of the features you'll find in other word processing
programs. Using its buttons and commands, you can format text to look as you want it to, embed images
and video, insert links, and more.

This topic lists some of things you can do in the editor.

Note:  Jive SBS has a special way to handle documents you create with Microsoft Office applications. For
more information, be sure to see How can I work with Microsoft Office documents? (page 25)

Using the Toolbar

The content editor's toolbar is pretty similar to what you'll see in many word processing programs. Use
these tools to format text and images, video, and insert special formatting. The things you can do are
described in more detail below.

Tip:  Check out the tooltips! Each of the buttons on the toolbar displays its name when you hover your
mouse pointer over the button for a second or two.
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Checking Spelling

The editor includes a way to check spelling when you want to. Click the Toggle spellchecker button at
the far right of the toolbar to check spelling for the content that's currently in the editor window. When
it's on, mispelled words will be underlined with red lines.

Click a mispelled word to view suggested alternate spellings, then click the suggestion that matches what
you want. Click outside the Suggestions list, somewhere else in the window, to make the list go away.

Click the Toggle spellchecker button to turn off the red lines. Note that the feature won't check spelling
as you type. Click the button again to recheck spelling.

Note:  You can change the language used for spellcheck by clicking the little down-pointing arrow at the
right side of the Toggle spellcheck button.

Resizing the Main Window

You can change the size of the editor window by clicking the window's lower-right corner and dragging the
corner up or down. (You can't make the window wider or narrower except by resizing the browser window
itself, but you can make it taller or shorter.)

Viewing Content in HTML

As you're writing your content, the editor is behind the scenes creating HTML code so your content can be
displayed in the web browser. If you're well-versed in HTML, you can create more ambitious formatting
effects by editing that underlying HTML directly. You click the HTML link at the right of the toolbar to
display the HTML markup; click Show Full Editor to go back.
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Be careful with this feature, though. It's actually not all that difficult to mess up the way your content
looks by incorrectly editing the HTML. If you're going to be doing a lot of editing this way, you might want
to have a full-featured HTML editor handy. You can copy the generated HTML markup out of the content
editor HTML window and paste it into your HTML editor while you work on it. When you're finished, copy
the edited markup back into the content editor's HTML window.

Note:  To help keep your content safe, there are a few HTML tags that will be ignored when the editor
translates your content into something everyone can see. You can include them and they'll be saved, but
they won't render when someone views your content. These tags include: <script>, <iframe>, <style>,
<link>, and <meta>.

Formatting Text

Pretty much all of the basic formatting tools you see in word processors are available in the content
editor.

Formatting Text
You can:

• Make text bold, italic, underlined, and struck through. You can also make it particular color.
• Change the typeface and size.
• Apply a style, such as for headings.

To format particular characters, select the text in the editor, then click the button for the kind of
formatting you want.

Inserting Links

You can insert links to sites on the web and to content in your community.

One way to start creating a link is to select the text you want people to click when they go to the place
you're linking them to. You can also put your cursor anywhere, without selecting, then click the Insert
Link button. If you do that, then the text people click will be the title of the community content or the
URL to the external web site. Even after you insert the link, though, you can still change the text people
see. In the editor, click inside the link text, then start deleting or typing to enter text you want.

When you want to link to community content, you can search for the item you want to link to or browse
the list of content you've looked at lately. Click the item you want, then click Insert.
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Note:  Links to external web sites need to begin with "http://" or "https://", which indicate to the
browser that you're linking to a web page. In other words, entering merely "www.example.com" won't
work -- it needs to be "http://www.example.com".

Adding Emoticons

You can embed emoticons, which are little images you can use when text alone just isn't enough. Click
the Emoticons button to see the list of images you can embed.

Embedding Images and Video

Have something to share that has to be seen? You can embed video and images so they appear amid the
text of your content.

Inserting Images

You can embed images that are on your computer and images that are already uploaded to the
community. You can also embed images that are on other web sites. When you click the Insert Image
button, you'll be prompted to choose the image you wan to embed. For example, if you've already
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uploaded an image, you can select it on the Uploaded Images tab, then click Insert Image to embed
it. To delete the image, click the red X at its corner.

Inserting Video

Embedding a video is just like embedding images. After you click the Insert Video button, you're
prompted to choose the video you want to embed. You can embed from already uploaded video or from
a video web site such as YouTube. For more, see How do I display video from the Web inside content?
(page 29) .

Also, if your community supports it, you can upload video you have, including video you've made yourself.
For more information, see How do I upload and insert video belonging to my community? (page 30)

Indenting and Aligning Text, Working with Lists

Some formatting effects larger blocks of text, such as paragraphs. That's what you're doing when you're
making lists, indenting, or aligning.

Inserting Bulleted and Numbered Lists

You can create numbered or bulleted lists. One way to start is to type the items you want for your list,
then select and format them (by clicking the list button you want). To remove the list formatting, select
the list text, then click the list button you clicked to format it orginally.

If you want to make a list that has indented sub-lists, start by making your list, including a sub-item
or two at the same level as the others. Then select the sub-items and click the indent button. You can
also have sub-list items use a different character than their containing list -- such as letters instead of
numbers. See the section below on list style for more.
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You can set a list's display style, such as whether it uses numbers or letters for individual items. To set
the style, select the list text you want to format, then right-click, point to List Style, and click the style
you want. Here's a list of the available styles:

• None -- Use nothing -- no numbers, letters or bullets.
• Inherit -- Use the style that the containing list uses. This option is only available then the selected

list item is a child of another list.
• Decimal -- Use a number with a decimal after, such as "4."
• Decimal with Leading Zero -- Use a number with a zero preceding, such as "04."
• Upper Roman -- Use an upper-case roman numeral, such as "IV".
• Lower Roman -- Use a lower-case roman numeral, such as "iv".
• Upper Alpha -- Use an upper-case letter, such as "D".
• Lower Alpha -- Use a lower-case letter, such as "d".
• Lower Greek -- Use a lower-case Greek character.
• Katakana, Katakana-Iroha, Hiragana, and Hiragana-Iroha are used in Japanese writing.
• Cjk-Ideographic are used in Chinese writing.
• Georgian is used in writing for the Georgian language.
• Armenian is used in Armenian writing.
• Hebrew is used in the Hebrew language.

Aligning Sections

You can align text in a paragraph left, right or center. You can also justify paragraph text so that both its
left and right edges follow straight lines. To change alignment, simply put your cursor anywhere in the
paragraph you want to format, then click the alignment button you want.

Indenting and Outdenting Sections

Indenting can be a handy feature to have. Of course, you can use it to call attention to blocks of text. But
you can also indent items in a list to have them become part of a sub-list. To indent text, select the text
you want, then click the Indent button. When you want to outdent in order to "undo" indenting, put your
cursor in the section and click the Outdent button.

If you're indenting a paragraph because the text is quoted from somewhere else, keep in mind that the
editor has a special way to handle quoted text. See that section for more information.

Working with Quoted Text and Code

Sometimes you want to call out sections of text (such as paragraphs) with different formatting.

Formatting Quoted Text

When you quote paragraphs of text you found somewhere else, such as in another person's post, it's
a good idea to format it as quote text. That way, other people can easily see what's yours and what's
someone else's.

When you format text as quoted, the published text will appear in a box that has grey shading.
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Formatting Code

The editor provides special support for formatting text that's from languages used by programmers, or
text that needs to look plain and unformatted. To apply the formatting described here, select the entire
block of text you want to format, then click the Insert button and point to the formatting style you want.
Note that these commands are intended for use with entire paragraphs, rather than just a few words.
Trying to use these commands with a few words inside a paragraph will

Here's a list of what you can do:

• Format text as plain -- like old-style typewriters made -- with the Plain command.
• Use the SQL, XML, and Java commands to format your text so that its syntax is highlighted when

then content is published.
• If you're familiar with HTML, you can use the Insert Raw HTML command to add HTML markup

that will be rendered when the content is published. In other words, if you insert <b>this is
bold</b>, you'll get this is bold. This is a way to add simple HTML.

Working with Tables

Once you've got a table, you'll find that you can make a lot of the changes you want by right-clicking
the table. When you right-click, you'll get a set of menu commands you can use to insert, remove, and
change settings for rows, cells, and columns.

Adding or Deleting a Table

To add a table, put your cursor in the place where you want the table to appear, then click the Insert
Table button. The editor will display a box where you can set your table's properties -- how many rows
and columns, etc. You can also change these properties after you've created the table. To do that, right-
click the table, then click Table properties.
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Adding or Removing Rows and Columns

Right-click the table to view commands for adding and removing rows and columns. For example, if you
want to insert a row between two rows, right-click the second row, point to Row, then click Insert row
before.

Tip:  A shortcut for adding rows to the bottom of your table is to use your computer's tab key. When you
press tab, the editor advances the cursor from one cell to the next, then from the last cell in the row to
the next row. When the cursor has reached the most lower-right cell, pressing the tab key creates a new
row with the same numWhenber of cells as the preceding row.

Moving and Copying Rows and Columns

You move a row or column by cutting or copying it, then pasting it before or after another row or column
to get it where you want it. For example right-click the row or column you want to move, point to Row,
then click Cut table row. Next, right-click the row you want the first row to appear beneath, point to
Row, then click Paste table row after.

Splitting and Merging Cells

You can merge two cells into one or split cells you've merged back into two. For example, to merge cells,
select the cells you want to merge, right-click the table there, point to Cell, then click Merge table cells.

Adding a Table of Contents

The editor includes a feature that automatically generates a hierarchical table of contents based on the
headings in your content. When you insert the table of contents in your content, the editor looks at
the headings your content uses, including their levels (Heading 2, Heading 3, and so on). Based on the
heading levels, the editor creates links to the headings, indenting the links at similar levels.

To insert the table of contents, click Insert, then click Table of Contents. While you're editing the
content, the presence of the table of contents will appear as an icon like the following:

In the saved or published version of the content, the icon will be replaced with a hierarchical list of links
to headings in your content.
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What's the difference between a document, a blog post, and a
discussion?

Documents, blogs, and discussions were born and raised on the Web, so you use them in Jive SBS as you
would there. The following table suggests ways to think about the content types.

 ' Documents Blog Posts Discussions

Purposes Collaborate with others on
a single document; capture
information that should
be available for a while;
create a report, agenda, or
meeting notes. See What
can I do with documents?
(page 23)

Express a point of view;
call something timely to
others' attention; make a
proposal to get feedback
from others; ponder an
idea. See What can I do
with blogs? (page 24)

Ask a question of the
community; ask for
suggestions; make a short
observation or assertion
to get feedback; report a
problem. See What can I
do with discussions? (page
25)

Format Most of the content is in
the document itself, with
some added in comments
by readers and authors.

Most of the content is
usually in the initial post,
with other content added
through comments by
readers.

Most of the content tends to
be in responses to the initial
question.

Style More formal, often in the
third person.

Informal, usually in the first
person.

Informal, usually in the first
person.

What can I do with documents?
Jive SBS is a place to create and keep track of documents. You can use the built-in documents to author
and edit content or you can upload files from outside Jive SBS.

• Documents are great for when a document will have more than one author — such as a document
that describes team plans or one that will need to be reviewed by others before it's ready to publish
to others. They're also an ideal place for just stashing information you want to hang on to for a
while, such as a list of insurance contacts for the Human Resources department.

• Uploaded files give you a way to include files authored with another tool, such as Microsoft Word
or Adobe PDF files.

For documents and uploaded files, you can:

• Specify the people who can edit a document, or who must approve it for publication. For more
information, see How do I limit who can edit a document? (page 34)

• Manage versions (page 31)  (of documents) so that you can see what changed from one version
to the next.

• Receive email notifications (page 39)  to know when the document is changed.
• Assign tags and categories (page 37)  to make the document easier to find by others.
• Display images (page 29) .

To start creating a new document, click New > Document.
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What can I do with blogs?
Posting to a blog is a great way to say something individual to other people in the community. Use a
blog to express an opinion, call attention to something noteworthy you've seen (such as an article on the
Internet), or make a proposal. Other people can comment on your blog posts, so that a blog is a great
way to pitch ideas that could impact the team or the company. Of course, you can comment on posts,
too.

Your community might include several blogs, each allowing posts from specific people. For example, you
might see "Bill's Blog" (with posts from Bill) or "Human Resources Blog" (with posts from people in the HR
department). Your administrator creates personal blogs, associating them with particular people. If you've
got something to say, get a blog going!

With blogs, you can:

• Assign tags when you're editing the blog.
• Import content from another blog. You'll need to first export the content to Movable Type format,

then navigate to your blog, click Manage Blog, then click Import.
• Save the blog as draft before you're ready to publish. When you're editing, click the Save button.

To view blogs, go to the home page and click Blog Posts. To post to your blog, click New > Blog Post,
select the blog you want to post to, then click Create new blog post.

To start a new blog post, click New > Blog Post. 

How can I manage my blog?
If you've got a blog, you can use its Blog Management page as a kind of dashboard to manage it. To
manage your blog, click the Your Stuff > Blog Posts menu. On the Your Stuff tab of your profile, click
the name of your blog.

The kinds of things you can do there include:

• Write a new post.
• View the latest posts, comments, and trackbacks (a trackback is a link to a blog that has linked to

yours).
• Import other blog content that's in the Movable Type format. This includes content exported from

TypePad, WordPress, and Roller.
• Subscribe to content or comment feeds from your blog (the feed technology used is set by a system

administrator).
• Set the blog's name and description, moderate comments and trackbacks, protect the blog by

requiring commenters to log in, and turn its feeds off.

How do I import content from another blog into my blog?
If you've got a blog in Jive SBS, you can import content from your other blogs. You'll need to first export
content from those blogs into the Movable Type import format. Some blogging tools offer the ability for
you to do that pretty easily.

Once you've got your exported content, you can import it into your Jive SBS blog using the following
steps:

1. In Jive SBS, go to your blog's Blog Management page.
2. Under Blog Shortcuts, click Import.
3. At the Exported file box, click Browse and select the file you exported from your other blog.
4. Click Upload File to import.

Note:  If you export content from Wordpress, you might need to do a little editing of the exported
content before you import it. When your Wordpress blog posts include HTML tags, the file exported from
Wordpress omits tags needed to tell Jive SBS that the HTML is there. You'll need to enclose the content in
<body> tags before importing. Here's an example:
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Before

This is my <b>BOLD</b> HTML example.

After

<body>This is my <b>BOLD</b> HTML example.</body>

What can I do with discussions?
Discussions are made for brief questions or ideas you want the community to see. Usually you make
a discussion post when you want to get quick feedback or know the answer to something. You can
specifically make a discussion a question (page 35) , such as when you have a specific question that
another person probably has the answer to. That will help ensure that your question gets the kind of
attention it needs.

When a discussion thread collects information that you want to preserve for other uses, you can save
the discussion as a document. For more information, see How do I convert a discussion thread to a
document? (page 31)  

With discussions you can:

• Attach files. Click the Browse button while you're editing the discussion.
• Display an images (page 29) . Click the Insert Image button while you're editing.
• Assign tags and categories (page 37) . Enter tags in the Tags box.

To start a new discussion post, click New > Discussion, select the space you want the discussion to live
in, then click Create New Discussion.

How can I work with Microsoft Office documents?
You can upload Microsoft Office documents to the community. With documents created from Office
versions earlier than 2003 (on Windows) or 2008 (on Macintosh), you can comment on the uploaded
document. With documents from later versions of Office, you can do more.

With documents created from Office version 2003 or 2007 (on Windows) or version 2008 (on Macintosh),
you can:

• View a preview of the uploaded document.
• Navigate through the document's pages.
• See comments made inside the document.
• Manage and sync the document with the community while working within Office (Windows only). For

more information, see Working with shared Microsoft Office documents (page 25) .

For more about uploading documents, see How do I upload a file? (page 30)

Working with shared Microsoft Office documents
With the Jive Desktop add-in for Microsoft Office, you can share your Office documents with others in
your online community. As you make changes to a shared document on your computer, Jive Desktop
synchronizes the document with the version that's visible in the community. This keeps the content on
the community up to date, but also synchronizes comments, tags, and collaboration settings between the
community and your document.

This feature is supported for Microsoft Office versions 2003 and 2007 running on Windows.

Note:  A shared document can be viewed and commented in the community, but it can't be edited there.
You continue to use an Office program to edit the document.

What You Can Do

With the Jive Desktop add-in, you can upload Microsoft Office documents to your community, then keep
changes to the document in sync while you work in Office.
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In particular, with Jive Desktop you can:

• Upload Office documents to your community without leaving Microsoft Office. When you upload a
document, the community displays a preview of the document (although it must still be edited using
Microsoft Office).

• Use the Jive group on the Office toolbar ribbon to:
• Turn automatic synchronization on or off. When it's on, the document will be synchronized to

the community automatically when you're saving changes.
• Change collaboration options to indicate who can edit the document in the community.

• Use the desktop panel to:
• Edit the document's title.
• Move the document.
• Edit collaboration options.
• View activity related to the document.
• View, add and reply to comments.
• View and add tags to help categorize the document in the community.
• Edit the document's description.
• View older versions of the document.

Get set up

You'll need the Jive Desktop add-in to share documents between Office applications and your community.
(Microsoft Windows is required.) If you don't have the add-in, you can get it when you're viewing an
uploaded Office document in the community.

To get the Jive Desktop add-in:
1. In your community, navigate to -- or upload -- an Office document.
2. In the Actions box, click Download the Office Plug-in.
3. In the dialog box that appears, click Save File to save the downloaded setup program.
4. Locate the file you downloaded and double-click it to run the setup program. If you're prompted to

open the executable file, click OK.
5. Click Run to run the setup program.
6. Follow prompts in the setup program to install the add-in.

Get connected to your community

After you first install the desktop add-in, it might not be set up to connect to the community you want to
synchronize documents with. To connect, you give the add-in the community's address on the web, along
with the username and password you use to log in to the community. There might also be other proxy
settings you'll need give. You can usually get those from an administrator.

1. In the Jive Desktop panel, in the upper-right corner, click the Settings button (it looks like a little
wrench).

2. Under Settings, type your community username in the top box and your community password in
the bottom one.

3. Click Network Settings to view Jive Desktop's connection settings.
4. In the Network Settings dialog box, in the Server box, enter the address of your community. This

will probably be the URL you use in a web browser to get to your community's home page.
5. If you need to enter proxy settings manually (your administrator will know whether you do),

select Manual proxy settings, then enter the proxy information you got from an administrator.
Otherwise, leave Automatically detect proxy settings for the network selected.

6. Select check boxes to set how you want the Jive Desktop to handle your documents. These settings
will be the defaults for all documents you work on.

• Enable Jive Desktop Plugin -- Clear this to turn off the Jive Desktop.
• Sync documents automatically -- Documents are kept in sync with the community unless

you click the Syncing button on the Jive Desktop ribbon group. The Syncing button will
show as enabled the next time you start the Office application.

• Send usage data to help improve Jive Desktop -- Select this to have the add-in send
information to the add-in's developers if something goes wrong. This data is completely
anonymous, and doesn't include anything about your document.
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7. Click OK.

Keep documents synchronized

After you've connected to your community, you can have Jive Desktop keep your documents synchronized
with the community. When automatic syncing is enabled, Jive Desktop does the following:

• Updates the document preview in the community when you save changes to the document's
content.

• Updates the community's document preview with inline comments added in Office.
• Updates the Office document comments list with comments made in the community.
• Keeps changes to community-related document properties in sync between the Office application

and the community. When a change is made in one place, it shows up in the other. These properties
include:

• Collaboration settings
• Tags
• The document's title
• The document's description
• Revision activity

If you don't have the Jive Desktop set to sync documents automatically, people using the community
won't see changes you make in Office. By the same token, while working in Office you won't see
comments that people in the community add to the document.

To enable automatic syncing, do one of the following in Jive Desktop:
• Click the Syncing button on the Jive Desktop toolbar ribbon so that it appears highlighted.
• On the top of the Desktop panel, click the Settings button (it looks like a little wrench), select the

Sync documents automatically check box, then click OK.

Add a document to the community

To have an Office document appear in the community, you either add it using the Jive Desktop or upload
the document from inside the community.

To add it using Jive Desktop, Jive Desktop must be able to connect to the community. See Get connected
to your community (page 26) .

1. Open the Office document.
2. If the document isn't yet in the community, Jive Desktop will display the Sync to My Documents

command.
3. Click Sync to My Documents.

The document will be added to the community. After this is done, Jive Desktop's Home tab will display
information about the document as content in the community. This includes a URL to reach it there, along
with other information.

To add the document inside the community, click New > Document, then select Upload a File.
Depending on the size of your document, it might take a few seconds to upload it.

Create a new document from an existing one

You can upload a document again if you want to make a new document you can start fresh with in the
community. Doing this saves you the trouble of saving your Office document as another document, then
uploading the new one.

This creates a new uploaded document in the community, leaving the previous uploaded document in the
community as it was when you last synchronized. The new document will have the content of the previous
one, but won't have its other properties, such as comments, collaboration settings, tags, and so on.

Note:  Making a new document in this way leaves you with an Office document that has the same
content, but without all of the community-related information. To get the previous Office document with
that information, go to that document's page in your community and click the Download link beneath its
preview.
To create a new document from an existing uploaded document:
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1. In Office, open the document you want to start from.
2. In the Jive Desktop panel, on the Home tab, click Reset this document.

Work with document versions

As you work on a document in Office, Jive Desktop keeps track of your changes, including community-
related information such as comments. If you have automatic syncing enabled, it will sync your changes
with the community. You can view the changes that have been made since previous versions of the
document while in Office. You can also save a previous version as the current one.
Note:  The version management feature does its work in part by using the change tracking feature built
into Office. That means that if you download a document that someone has made changes to, you might
see revision marks placed there by the change tracking feature. The document is fine, but the revision
marks can make it hard to read. You can hide the marks in the following ways:

• In Word 2007, select the Review tab. In the Tracking group, select "Final" for the "Display for
Review" dropdown to hide the changes.

• In Word 2003, locate the Reviewing toolbar. In the "Display for Review" dropdown, select "Final".

Work with document revisions

Jive Desktop creates a new version of a document whenever you save changes to the document.

To view previous versions of a document:
1. In Office, on the Jive Desktop panel, click the Information tab.
2. Under Versions, if the list of versions isn't visible, click the triangle to display it. Previous versions

will be listed with the name of the person who saved them and the time when they were saved.
3. From the list of versions, click the one you want to view.

To save a previous version as the current one:
1. In Office, on the Jive Desktop panel Information tab, click the version of the document you want

to save.
2. In Office, with the older version displayed, on the Jive Desktop panel, click Make this the latest

version.

Work with document activity

Jive Desktop displays a list of activity related to the document. This activity includes versions saved
and comments added. By clicking an item in the activity list, you can get more information about it. For
example, clicking an item about comments added will display the list of comments.

To view document activity:
1. In Office, on the Jive Desktop panel, click the Home tab.
2. Under Activity, view the list.
3. To see details about a particular item, click it.

Move a document

Just as you can when you're using the community, while you're using Jive Desktop you can move a
document from one space in the community to another.

To move a document:
1. In Office, on the Jive Desktop panel, click the Jive Desktop Home tab.
2. Under Overview, click move.
3. In the Move document dialog box, click the name of the space you want to move the document to.

If you don't see the space listed, you can search for it.
4. Click OK to move the document.

Add a comment

Comments you add while working on a document in Office are synchronized to the community. In
addition, comments people add to your document in the community will appear in Office.

There are two kinds of comments for shared Office documents:
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• Document comments are like those people make elsewhere in the community. People can usually
comment on shared documents just as they comment on other kinds of documents. These are
added in the community, but only viewed (or replied to) in Office.

• Inline comments are those you make in Office, and which appear in the document itself. An
inline comment is a way to add a comment to a particular part of the document. When you add an
inline comment, it shows up in the community on the inline comment tab at the bottom of the
document, as well as in the document preview. These are added in Office, but can only be viewed in
the community.

Both kinds of comment are visible in both Office and the document view in the community. In Office,
you'll see them on the Comments tab of the Jive Desktop panel. You'll also see document comments in
the document itself. In the community, comments appear beneath the document text, on Comments and
Inline Comments tabs.

To add a document comment:
1. In your community go to the bottom of the document view and click the Comments tab.
2. Click Add a comment, then type your comment and click Add Comment.

You can also click Reply to reply to an existing comment.

To add an inline comment:
1. In Office, on the Jive Desktop Comments tab, click Add.
2. In the new box that appears under Comments, type your comment, then click OK.

You can also click Reply beneath a particular comment to write a reply to that comment.

Add collaborators

By default, when you use Jive Desktop to add a document to your community, the document's
collaboration options are set so that only you can edit the document. You can change this so that others
can edit as well.

To change collaboration options:
1. On the Jive Desktop toolbar ribbon, click the Share button.
2. In the Collaboration options dialog box, select an option to set who can edit:

• Just you -- Only you can make changes to the document's content.
• Anyone -- Anyone in the community can make changes.
• Specific people -- Only the people whose names you choose can make changes. If you select

this, begin typing the person's name in the box beneath Specific people. When their full
name appears, click it to add it to the list.

3. Click OK.

How do I display an image within content text?
You can include an image in the text of your content. Here's the step-by-step process:

1. Navigate to the content and click the link to edit it.
2. Click the Insert Image button on the toolbar.
3. In the Insert Image page, upload an image from your computer, browse for an image you want to

add, or insert one from the Web.
4. Click Insert Image.

Note:  Keep in mind that big images don't scale to a smaller size when you view content as a PDF file. If
you think it's likely that someone will want to view or save your content as PDF, then you should make
sure that the image displays completely in the content in your web browser. You can also test the display
by viewing the content as a PDF yourself.

How do I display video from the Web inside content?
You can have video from another site, such as Vimeo.com or YouTube.com, displayed in your content. The
video itself isn't attached to your content, but linked from the site itself.

1. Navigate to the content and click the link to edit it.
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2. Click the Insert Video button on the toolbar.
3. If your community supports uploading videos, you'll see a From the Web tab. Click From the Web

to link to a video rather than upload one.
4. Select the type of video you want displayed (such as Vimeo or YouTube),
5. Enter video information by pasting it into the video URL/code box. You can get that information from

the video site. For example, when you're watching a YouTube video you'll find an embed box with
the code inside. Here's an example (yes, they can be kind of long!):

<object width="425" height="344"> 
    <param name="movie" value="http://www.youtube.com/v/mji4nAk_8ZY&hl=en&fs=1"></param> 
    <param name="allowFullScreen" value="true"></param>
    <embed src="http://www.youtube.com/v/mji4nAk_8ZY&hl=en&fs=1" 
        type="application/x-shockwave-flash" allowfullscreen="true" 
        width="425" height="344">
    </embed> 
</object>

6. Copy that code from the site and paste it into the video URL/code box in Jive SBS.
7. Click Insert Video to add the video into your content. When you publish the content, others will be

able to play it.

How do I upload and insert video belonging to my community?
You can upload your own video for viewing by other people in the community. If you have a webcam, you
can even record the video you're uploading. As with other content, you can add a title, comments, and
tags to go with your video. You can also browse videos that have been added by other people.

You can upload files of the following formats:

• Supported video file types -- AVI, MOV, WMV, MP4, MPEG, FLV, 3GP, and 3G2.
• Supported video codecs -- All of the popular MPEG-4 variants like DivX, XviD, H.264, 3IVX, and

MSMPEG4, plus Windows Media 9.
• Supported audio codecs -- MP2, MP3, WAV, AAC (typically seen in QuickTime files), Windows Media

audio, and for mobile devices AMR in both narrow-band and wide-band varieties.

To add video to the community, use the following steps:

1. Click New > Video.
2. Choose a location in the community for the video.
3. On the Create New Video page, add information and upload your video.

• Add a title and description.
• Add tags so it's easier for others to find the video.
• Browse for a video to upload or record a video with your webcam.

4. Once you've selected or created a video, click Upload to add it to the community.

Note that it might take a little time for the video to be uploaded and prepared for the community.
Until that's done, no one will be able to watch it.

After you've uploaded videos, you can add them to content. To do that, click the Insert Video button
while you're writing your content. In the Insert Video box, you can choose from your uploaded videos,
choose one from your computer, or record one right then.

How do I upload a file (such as a Word or Excel file) so that other
people can see it?

Uploading a file is a great way to include an externally-authored document or track its progress. For
example, you can upload a document, then add collaborators so that it gets reviewed by other team
members.

You can also attach files to other content, such as documents, discussion posts, and blog posts. 

To start uploading a file, click New > Document, then click Uploaded File.
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How do I see how a document was changed between versions?
You can view the differences between two versions of a document that has been edited and published
multiple times. You can also delete specific versions or restore a previous version so that it is the current
version.

To manage a document's versions, navigate to the document and then click Manage Versions. On
the Manage Versions page you can view changes in one version from the preceding by clicking the
Changes icon for the later version; you can select the check boxes for any two versions to compare
them. You can also restore and delete previous versions.

How can I create content just for myself?
You can create content such as documents that doesn't go into one of the other places, such as an
existing space or group. So when you create a discussion or a document, for example, you can say that
you want it to go in "your documents" or that you want to create a "private discussion." When you do,
you'll be able to get to it later on your profile.

How can I create a private discussion?
You can start a discussion that only a few people can see. When you create a private discussion, you can
find it later by going to your profile.

To start a private discussion:
1. Click the New menu, then click Discussion.
2. Under Choose Location, if Private Discussion isn't listed, click Browse for More Locations,

then click Private Discussion.
3. Under Participants, enter the names of people who you want to include in the discussion. You can

also click Select People to browse for them.
4. Type the starting message of your discussion, then click Post Message.

The people you invited as participants will be able to get to the discussion by clicking Your Stuff >
Notifications.

For more information about the places you can create content, take a look at Where can I find and put
content? (page 4)

How do I move a discussion thread to another space?
To move a discussion thread from one Jive SBS space to another, navigate to the discussion and click
Move Thread.

How do I convert a discussion thread to a document?
When you want to save a discussion into another format — such as to preserve its information for another
use — you can convert the discussion thread to a document. When you do, you'll create a new document
that contains the original post and all replies in the discussion. You can edit the new document and save
it. The discussion itself will not be removed.

To convert a discussion to a document, navigate to the discussion, then click Convert discussion to
document. 

How do I lock a thread so others can't comment on it?
If you're an administrator or moderator, you can ensure that no one will be able to add more replies to a
discussion thread. Navigate to the discussion thread and click Lock Thread.

How do I create new content without logging in?
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If your community supports it, you can post new content simply by sending an email to the community.
This can be especially handy for posting when you can't reach the community using a browser. For
example, you could email content from a cell phone that sends email.

Each place in your community -- from spaces to projects to groups, for example -- provides email
addresses for the content you can post via email. By sending email to the address corresponding to
documents in the place, for example, you can create a document there. The subject line of your email will
be the document's title, while the email's body will be its content body. Even your user profile provides
email addresses for content you can post. For example, you can change your community status message.

To create content with email:
1. Go in your community to a place where you want to create content.
2. Under Actions, click Create by email.
3. In the Create By Email dialog box, select the check box for the content you want to create.
4. Click the Download vCards button.
5. When you're prompted, save the vCard (.vcf file) to your computer.
6. After you've saved the vCard, click Done.
7. In your email or address book program, use the vCard you downloaded to add its email address as

a contact. For example, in Microsoft Outlook you can drag the vCard to your Contacts folder. On a
Macintosh, you can double-click the vCard to add it to your address book.

8. In your email application, start a new message you'll send to the address you just added.
9. In the email's subject, type the title you want your content to have.

10. In the body of the email, type the main part of the content.
11. Send the email to create the content.

How do I post a reply without logging in?
If you're subscribed for email notifications to content, you can post a reply simply by replying to
notification email. For example, imagine you're subscribed to notifications on a discussion thread. When
someone posts a reply to the discussion, you'll get an email about it. Reply to the email, type your
discussion reply just as you'd type a reply to any email, then send the email. If the community is set up
to receive replies via email, your reply will be posted as if you'd logged in and posted it.

When posting this way, be sure to leave the special code at the end of the subject line. The code will be
numbers and letters in square brackets, like so: [Xxxxx-xxx-xxxx].

Note:  The post-from-reply feature isn't supported when the reply is a digitally-signed email.

How do I embed content from one community into another using a
bridge?

If you're a member of two communities that are connected using a bridge, you can have content from
one community appear in the other. (A bridge is something set up by your administrator. You'll know
your community is bridged if you can set its preferences by clicking Your Stuff > Preferences.) When you
bridge content from one community to another, a copy of the bridged content appears in the destination.

For example, imagine you work for a company that has an internal employee community where you
and your coworkers talk about the work (and maybe fun things) you do. But the company also has a
public community that its customers use to get information and support about your products. If the two
communities are bridged, you can have content from one community appear in the other. The kinds of
content that you can bridge include discussions, documents, and blog posts.

Suppose a customer posts a request for a new product or feature on your public community. Because
they include a lot of specific information about what they want and why, you want to make their post
visible to people on your employee community. That way, you and your coworkers can have a separate,
behind-the-scenes discussion about the feature request. You might even want to make parts of your
internal discussion visible to people on the public community (such as a description of the new product as
you eventually design it).
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Note:  When you bridge content, you're copying content from one place to another rather than linking a
live version. That means that the version at the destination (here, the internal community) isn't updated
as its source counterpart changes. Even so, you'll get cues when the source changes, such as with new
replies.
To start bridging content, you'll first need to let the community know that you're a member of both.

1. Click Your Stuff, then click Preferences.
2. Click the Bridge Preferences tab.
3. If more than one community is connected to the one you're looking at, find the other one in the list.
4. Next to Account credentials, click the Connect in... link.
5. Enter the username and password you use for the other community, then click Send.

The basic steps for bridging content are essentially the same whether you're bridging a discussion,
document, or blog post (be sure to use the helpful links along the way in the user interface for
guidance!).

Here's how to bridge a discussion, where you want to bridge a discussion from an external public
community to an internal employee community.

1. In the public community, go to the discussion you want to bridge.
2. In the bridge menu at the bottom of the page, click the tab that has the name of the employee

community (you can see this because you connect with your account credentials earlier).

On the bridge menu, you'll see whether any other content is already bridged from this one, as well
as a link back to where you can adjust your bridge preferences.

3. Click the Discuss this link.
4. Under Choose location, choose the place on the employee community where you want to create a

discussion that has content from the one you're bridging.
5. Under Select which part, select check boxes for the parts of the discussion you want to copy to

the employee community. Only those you select will be copied over. You can hover your mouse over
View excerpt to see what each one says.

6. Click Continue.
7. Enter a title for the discussion you're creating. Because you're actually creating a new discussion on

the employee community that embeds content from a discussion on the public community, you need
to enter a title for the new one here.

8. Enter other content if you like.
9. To see a preview of the bridged content, click Preview embedded content. In the preview, be

sure to click View the rest of this bridged content if you want to see everything you selected.
If you've changed your mind about what you want to include, after you close the preview click the
Selected button in the upper right corner of the page.

10. Click Post Message.
11. After the discussion you're bridging has been uploaded to the other community, under Go to the

new message, click the link to see the new discussion message you've posted. You'll be take to the
other community -- here, the employee community.

12. Notice that your new post embeds the content you selected from the original. From here you can:
• View the original discussion in the other community.
• View the rest of the content, such as the replies to the discussion.
• View content information, including where it came from and what its current condition is.

So while the embedded content won't change as its original changes, you can still see here
whether the number of replies and views has changed.

• See information about bridged content and how it works.

If you've had some discussion around a bridged piece of content, you might want to get some of that
discussion back into the original content. For example, imagine you've bridged a customer discussion
into your employee community, where you and others have discussed the embedded original, replying to
the employee message you created. You arrived at something that you want to communicate back to the
public community. In a reply to the original public discussion, you can include excepts from the employee
discussion -- without showing the employee discussion to the public.

To reply with content from the other side of a bridge:
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1. Go to the original discussion thread.
2. At the bottom of the thread, click Reply to original post.
3. At the bottom of the content window, click the Quotes from link to view a list of content from the

discussion you created earlier to embed the bridged content.
4. Under Insert a quote, select check boxes for the parts of the content you want to copy into the

original discussion, then click Insert.
5. Notice that the text from the content parts you selected has been pasted into the new reply you're

writing. There's no other sign that the employee discussion exists.
6. Finish your reply using the content copied from the other discussion.

Collaborating

How do I create a document that other people can work on?
By default, when you create a new document, the new document allows multiple authors. In other words,
by default anyone else can make changes. You can also limit the list of people who can make changes
(page 34) .

How do I limit who can see or edit a document?
You can create a document that only certain people can see or edit. How you set this up depends on
where the document is in the community and whether it has been published or not. Here's how it works:

• For the best control of visibility and collaboration for the life of a document, save it in (or more it
to) Your Documents. With a document in Your Documents, you can set its visibility to just yourself,
just the people you specify, or anyone in the community. You can set its availability for editing in the
same ways.

• For a document saved to other places in the community (outside Your Documents), keep in mind
that it only remains invisible to others until you publish it -- there's no way to set it to "not visible."
Once you publish it, others can see it. However, you can set who is able to edit the document
whether it is a draft or published.

You can set visibility and collaboration for a document either while you're editing or while you're simply
viewing the document. Here are the steps for the setting a document so that only certain people can edit
it:

1. In the Actions list, click the collaboration link:
• Visibility and Collaboration if the document is in Your Documents.
• Manage collaboration if the document is not in Your Documents.

2. If the document is in Your Documents, under Visibility choose Open to anyone or Just specific
people (if it's "just you," you won't be able to add collaborators). If you choose "specific people," be
sure to enter the names of people who you'll want to edit the document.

3. Under People who can edit this document, click Specific people.
4. Click Select People to browse for the names of people you want to be able to edit the document.

For each person able to edit the document (including yourself), they'll be able to reach the
document from their Your Stuff menu or in their profile on the Your Stuff tab.

Note:  Remember -- if you If you want to keep a document that's not in Your Documents hidden, don't
publish it! Once you publish it, it will be visible to anyone who can see documents in the place with the
document.

How do I make it so that someone must approve a document before
it's published?

You can create a document that someone needs to approve before it can be published. You can do this at
any time before you publish the document -- such as when you first create it or after you've saved it as a
draft.

Note:  An administrator might already have chosen someone to approve documents in a space.
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While you're editing the document, click the Collaboration Options link. Under Users who must
approve for publication, enter the name of the person who should approve. You can also click Select
Users to browse for the person's name.

How do I announce something so that other people are more likely
to see it?

You can post an announcement that will appear on the home page for a particular space. 

To create an announcement, navigate to the space's home page and click Create an announcement. On
the Post Announcement page, you can type the announcement text as well as when and for how long
the announcement will be visible.

How do I ask a question?
Ask a question by posting it as a discussion. There might be another person who has the answer to your
question and can post a reply. You can mark a discussion post specifically as a question when you create
the post. (If you don't initially mark the discussion as a question, you'll have 15 minutes to change your
mind after you post. Within that time, you'll see a link to change your mind in the discussion post.)

To post a question, click New > Discussion, then choose a location. Under Start a New Discussion,
after titling and describing your question, be sure to select the Mark this discussion as a question
check box before clicking Post Message. 

Note:  You can also ask a question as a poll (page 35) . 

If someone answers my question, how do I say so?
If you post a question and someone replies with information that you can use, it's a good idea to mark
their reply as either helpful or correct. That way, others who have the same question can quickly see
which replies might be most useful for them. A helpful reply is on the right track, while a correct reply
answered your question. Keep in mind that you and others get more status points for posting replies that
are marked as helpful or correct! When you feel that your question has been answered, you should mark
the original question as answered. That way, people will know whether or not to keep trying to answer
your question.

To mark a response to your question, go to the question in the community, look for responses, and click
Helpful Answer or Correct Answer on each response that fits.

How do I create a poll?
A poll is a way to ask a multiple choice question of other people in the community. When you create a
poll, you define the question and the possible answers. The poll appears on the home page for the space
it's created in. As people respond to the poll, results are shown graphically as colored bars. (A person can
vote only once in the poll.)

To create a poll:

1. Navigate to the space where you want the poll to live.
2. Under Actions, click Create a poll.
3. Give the poll a name and description. The name will appear above the list of options, so you should

use it as the poll's question. An example might be, "Where should we have the holiday party?". The
description will appear on the page that lists the poll's full results.

4. Set when the poll will first be available to other community members. You can make this now, or at
a later date.

5. Set when the poll should end. When the poll ends, it will stop being available for responses and
people won't be able to vote anymore. People will still be able to view the poll's results.

6. Set when the poll expires. When it expires, people will not be able to see either the questions or the
results.
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7. Create options. Here's where you add the choices. Example choices for the holiday party poll might
be, "In the office", "In a restaurant", "At someone's house", and so on.

Finding Content

How can I find content?
As the amount of activity in your community grows, you'll get more out of it by using these tools to find
what you need. In particular, be sure to personalize your home page, using the widgets to filter out the
things you're probably not interested in anyway.

Here are some of the tools you can use to find content:

Widgets.Personalize your home page (page 5)  with widgets that display links to the things you want
to see. For example, the Watch A Tag widget will filtering out everything except content tagged with the
tag you want.

Searching. You can search for content using the search box in the upper right of each page. Enter your
search phrase. Notice that a search is done for you as you type -- click an item that looks promising. Click
the Search button if what you're looking for doesn't show up in the list. See results on the Search page.
Be sure to see the search tips for a few power user features.
Note:  When you're on the Search page, the search box in the upper-right corner and the main search
box behave slightly differently. The box in the upper-right corner invisibly appends an asterisk (*) so that
it lists more results. This is a convenience feature.

Browsing. One of the easiest ways to browse for content is to use the menus at the top of each page:

• The Your Stuff menu lists things that are specifically about you (such as your profile or
preferences) or that you created (such as documents, blog posts, and discussion posts you made).

• The History menu lists pages you've looked at most recently. Note that this history is related to
your browser's; if you delete your browser's history, your community history will go, too.

• The Browse menu gives you a way to go to pages where you can browse for content. You can also
browse for content, people and by tags by clicking the icons at the top right of the home page.

Bookmarking. You and others can bookmark (page 38)  content as a way to find it more easily
later, but also to point out things you think deserve more attention. You can bookmark content in the
community or sites outside it. When you bookmark something, you can add notes and tags for others to
use (although you can also make bookmarks personal).

Tags. When people assign tags (page 37)  to content you can use the tags to find the content again.
The community displays tags in a "tag cloud" where you can click a tag to see the content associated with
it. For example, if you navigate to a space home page (on the community home page, click the Spaces
icon, then click the name of the space), you'll likely see a tag cloud of popular tags. Notice that the tags
listed there are in alphabetical order, but that they're displayed in different letter sizes. The larger a tag
name is, the more content it's assigned to.

How do I make something easier to find?
To help other people find the content that you create, try the following:

• Put the content in a place where it's likely to be discovered. For example, be sure to choose the
best space in which to create the content. (Note that after you create a document in one space, you
won't be able to move it to another.)

• Bookmark (page 38)  content so that you and others can find it simply by browing bookmarked
items.

• Apply tags and categories (page 37)  to the content. Tags give other people a way to find things
based on the ways your community thinks about them.

Don't forget that you can make yourself easier to find by adding information to your profile that other
people might be interested in looking for. What are you good at? What do you know? Add these to your
expertise list. For more about profiles, see How do I edit my profile? (page 3)
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How can I draw others' attention to certain content?
If you're an administrator, you can shine a light on certain pieces of content in a place by adding them
to featured content. When you add something to featured content, the featured content widget will list
it among other featured items. Use the Featured Content widget when you customize a place overview.
Putting the widget at the top of the page will draw people's attention to items they might want to see
first. For example, this is a good place to draw attention to discussions or documents that address
frequently asked questions, guidelines for using the place, and so on.

Note:  Featuring videos works slightly differently. A video can be featured in one place only. Use the
Featured Video widget instead of the Featured Content widget.
To add something to featured content:

1. In the community, go to the content you want to feature.
2. Under Actions, click Add to featured content.

What are tags and categories?
Tags are like index keywords that you and others assign to content and use to look for content (page
36) . When you create or edit content, you can assigned tags to the content to describe it for people
who might search for it later. One way to do this is to ask yourself what tags you would use to look for
this content if you were searching for it.

Categories are words or phrases predefined by administrators, usually in a way that's specific to a
particular place (a space or social group, for example). If there are categories available in the place, it
usually means that the place's administrator has given thought to ways that the place's content should
be grouped. When an administrator creates a category, they can optionally associate certain tags with
it behind the scenes. If they have, and you type any of those tags in the Tags box, you'll see that
category's name highlighted. This is a cue to consider assigning your content to the category.

How do I apply tags and categories?

You can assign tags and categories to content when you're creating or editing it.

To assign tags to your content:

1. Open the content for editing and scroll to the bottom of the page.
2. Beneath the editing window, in the Tags box, type the tags you want to assign to the content (be

sure to use underscores to separate words in tags that have more than one word). Pay attention
to whether any of the tags you enter cause categories (if there are any) to be highlighted; if so,
considering assigning your content to highlighted categories.

Where possible, it's best to use tags that already exist. That way, you stand a better chance of
assigning tags that people are already familiar with and that might be assigned to related content.
The easiest way to apply existing tags is to just click the name of a tag in Popular Tags list; if you
know the name of an existing tag (or if it's not listed), you can also just type it.

To assign your content to categories:

1. Open the content for editing and scroll to the bottom.
2. Beneath the editing window, under Categories, you might see a list of categories that have been

defined for the place in which the content lives. Select check boxes for the categories in which your
content seems to belong.

How do I keep track of content I like?
When you want to keep your eye on particular content, you can use bookmarks, feeds (such as RSS) and
email notifications.

• By bookmarking content (page 38)  (both inside and outside the community), you can get back to
it quickly later. You can even make the bookmark visible to other people so that they can find it and
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know what you're keeping your eye on. With notes on your bookmarks, you can describe why you
like (or don't like!) the bookmarked item.

• Feeds (such as RSS) (page 38)  give you a way to see information about content changes and
additions all in one place. To view the list of changes you use what's called a "feed aggregator," or
"feed reader." By subscribing to feeds (page 38)  and using a reader you can view updates about
content changes and additions through a single tool.

• With email notifications (page 39) , Jive SBS sends you an email each time content you're
interested in (that is, for which you've requested email notification) is changed or added. Requesting
email notification is a way to get updates about content changes and additions in a more immediate
way.

What are bookmarks?
If you're familiar with social bookmarks and Digg, you might see what's great about bookmarks. You can
bookmark any content in the community, and even sites outside the community. Bookmarking something
adds it to the list of your bookmarks (either public or personal) under the Your Stuff menu for easy
retrieval later. You'll also be adding to the number of people that have bookmarked that item. So you can
easily see if content is popular based on the number of people who have bookmarked something. If you
want to see the things that other people have bookmarked, click Browse > Bookmarks.

With bookmarks, you can share the things you find with other people in the community. One easy way
to do this is to add the community "bookmarklet" to your web browser. With this little tool, if you find
content on an external site that you think would interest others in the community, you can simply click
the Add to Jive SBS button in your browser, and the bookmark will be added where other people can find
it and even comment on it. To get the bookmarklet, go to Your Stuff, then click Bookmarks. If you
don't yet have the bookmarklet, you'll see a message describing how to install it.

To bookmark inside the community, navigate in your browser to the content you like, then click
Bookmark This under Actions. To bookmark a site outside the community, click New > Bookmark,
then enter the URL for the site you like. You can add notes and tags to go with your bookmark. Let others
know what you like about it!

You can make it easier to bookmark in your community sites you find on the Web. You do this by adding
a special button to your browser's toolbar. Click Your Stuff > Bookmarks. In the box at the top of the
page, click Install the button, then drag the button from the Add Site box to your browser's toolbar.

What are feeds (such as RSS)?
Feeds are a way for you to keep track of changes or additions to content you care about. (RSS is a
popular feed type; "RSS" stands for "Really Simple Syndication.") By "subscribing" to the feed for content
in the community, you're asking to have easy access to information about content changes or additions.
A feed brings you a list of updates that you can view in a feed reader (also known as an aggregator).
See How do I use the feeds I get? (page 38)  for more info. Subscribing to feeds is an alternative
to receiving email notifications (page 39) , in which an email is sent each time content is changed
or added (although you can also do both). You might prefer email notifications if you want to receive
updates in a more "passive" but immediate way.

You can subscribe to feeds (page 38)  for content lists (such as a list of blogs, discussions, or
documents you'd view), spaces, or for discussion threads.

How do I use the feeds I get?
To view feeds (page 38)  you use a feed reader (also known as an aggregator). A reader is designed
to collect information about content from the places whose feeds you've subscribed to. This could be
as simple as using your web browser to collect the feeds (recent versions of Firefox, Internet Explorer,
and Safari support this). To try this out, simply go to a community or piece of content you want to
receive updates on and click the feed icon  there. There are also reader applications that are specifically
designed to help you collect feeds.
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Note:  When you're adding feed subscriptions to your feed reader, you might have to associate your user
name and password with the subscription. That's because the feed reader is getting information from Jive
SBS on your behalf. Jive SBS needs to know it's not giving the information to just anyone!

For the feeds you've subscribed to, you'll typically get a list of summaries for content that has recently
been added or changed. You can view the content itself or mark it in the list as having been "read."

To subscribe to the feed for content, you add the link URL for the feed to your feed aggregator. One way
to get the URL is to click the feed icon when you're viewing content, then copy the URL out of the address
bar at the top of your browser. You can also get the URL from a list of all the available feeds for a space
by clicking Subscribe via RSS under Actions.

Note:  Some browsers will display a feed symbol at the right side of the address bar (at the top, where
the page URL is). If you click the symbol, you'll get a list of the feeds available. This is a good way to get
feeds for documents, for example.

What are email notifications?
You can have the community send you email when content you care about is added or changed. This is
an alternative to feeds (page 38) , which require a feed aggregator (although you can use both feeds
and email notifications, of course). Because an email is sent for each notification you request, you might
prefer subscribing to feeds if you'd rather not get all the email.

To begin receiving email notifications, navigate to the area you care about — a space or document or
blog, for example — and click Receive email notifications under Actions. To stop receiving email
notifications, click Stop email notifications instead.

How can I work with content in my other communities?
If you're a member of more than one community, those communities might be connected to each other.
If they are, while you're in one community you can see into the other through widgets. Communities are
connected to each other by a community administrator. If your communities aren't connected, you won't
see ways to view content from one inside another.

When you're personalizing your home page, be sure to look to see whether there are tabs of widgets
for other communities you're a member of. For more information, see How can I personalize my view of
content? (page 5)

Managing Projects

What is a project?
With a project, you collect people's content in a way that focuses their work along a schedule toward a
specific goal. A project is a great way to give collaborative work a context that's time-based and outcome-
based.

Like a space, a project can contain various kinds of content, but it can also contain tasks. You can create
tasks with titles and descriptions, assign them to people, set due dates, and mark them as complete. As
with other content, you can assign tags to tasks, too.

You can add checkpoints to a project as a way to focus efforts to make sure your project is going as you
intend. A checkpoint is merely a named place in the schedule, and it's often used as a point at which to
take stock.

To help you manage your project's progress, Jive SBS provides visual cues that snapshot the project. On
a project's home page (which you can customize with widgets, as with other main pages), you'll get a
checkpoint timeline that shows where your checkpoints are between the project's start and finish, and
where the current date falls on the timeline. A project calendar captures task due dates and checkpoint
dates in a traditional calendar style.
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How do I create a project?
To create a project, click New, then click Project. Choose a location for the project. Give the project a
name and include descriptive details, then add a target date for completing the project. Click Save to
enter your new project's home page.

How can I see project content outside the project?
You can only see content for a project outside the project if you're able to get into the project itself. If you
are, then project content will show up in your searching and browsing, as with other content. You can also
use widgets as windows on project content. For example, you could personalize your home page with the
Your Tasks or Your Projects widgets so you can stay on top of the things assigned to you.

How can I copy task information between a project and another
project management tool?

You can import and export tasks between a Jive SBS project and other project management tools. To
import task information, first export the information from your other project management tool, saving
it as a comma-separated values (CSV) file. After exporting, go to your project in Jive SBS and click
Import/Export Tasks in the Actions list. On the Import/Export Tasks page, under Import tasks
from a CSV file, click Browse to locate the CSV file you exported, then click Upload File. The next page
shows the column titles for Jive SBS tasks (such as "Description Field," "Assigned To Field," and "Due
Date Field"), with dropdowns that list column titles found in the CSV you're uploading. Use the dropdowns
to map a different CSV column title to each of the titles in the Jive SBS project. This will determine where
the information will go in the Jive SBS project. The page displays a preview using information found in
your CSV file. Click Proceed to accept the mappings. On the next page, you can clear check boxes for
those items you don't want to import. You can click the edit link for a task to edit task information before
you import it. Click Import Selected Tasks to import the information.

When you export task information from a Jive SBS project, you begin by clicking Import/Export Tasks,
then choose Export or Choose Tasks.
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